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Preface

Profile

Before You Begin This Course

Before you begin this course, you should have the following qualifications:

•  Thorough knowledge of Oracle Bills of Material

•  Working experience with Oracle Bills of Material

Prerequisites

•  There are no prerequisites for this course.

How This Course Is Organized

Oracle Manufacturing – Create Routings  is an instructor-led course featuring
lecture and hands-on exercises.  Online demonstrations and written practice
sessions reinforce the concepts and skills introduced.
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Related Publications

Oracle Publications

Title Part Number

None

Additional Publications
•  System release bulletins
•  Installation and user’s guides
•  Read.me files
•  Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab
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(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.
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3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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Oracle Engineering > Resources

Oracle Bills of Material > Resources

Oracle Engineering > Resource Costs

Oracle Bills of Material > Resource Costs

Oracle Engineering > Resource Overhead Associations

Oracle Bills of Material > Resource Overhead Associations

Oracle Bills of Material > Quick Codes (CRP_RESOURCE_GROUPS)

Oracle Bills of Material > Simulation Sets

Oracle Bills of Material > Department Classes

Oracle Bills of Material > Location

Oracle Engineering > Departments

Oracle Bills of Material > Departments

Oracle Engineering > Overhead Rates

Oracle Bills of Material > Overhead Rates

Oracle Engineering > Resources

Oracle Bills of Material > Resources

Oracle Engineering > Shifts

Oracle Bills of Material > Shifts

Oracle Engineering > Capacity Changes

Oracle Bills of Material > Capacity Changes

Oracle Engineering > Engineering Routings

Oracle Bills of Material > Routings

Oracle Engineering > Routing Revisions

Oracle Bills of Material > Routing Revisions
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Oracle Engineering > Viewing Routings

Oracle Bills of Material > Viewing Routings

Oracle Engineering > Reports

Oracle Bills of Material > Reports

Oracle Engineering > Operation Resources

Oracle Bills of Material > Operation Resources

Oracle Engineering > Standard Operations

Oracle Bills of Material > Standard Operations

Oracle Engineering > Resources

Oracle Bills of Material > Resources

Oracle Engineering > Resource WhereUsed

Oracle Bills of Material > Resource WhereUsed

Oracle Engineering > Attachments

Oracle Bills of Material > Attachments

Oracle Engineering > Operation Documents

Oracle Bills of Material > Operation Documents

Oracle Engineering > Common Routing

Oracle Bills of Material > Common Routing

Oracle Engineering > Copy Routing

Oracle Bills of Material > Copy Routing

Oracle Engineering > Import Bills and Routings

Oracle Bills of Material > Import Bills and Routings

Oracle Engineering > Engineering Master Items

Oracle Engineering > Engineering Organization Items

Oracle Inventory > Master Items
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Oracle Inventory > Organization Items

Oracle Engineering > Engineering Routings

Oracle Bills of Material > Routings

Oracle Engineering > Operation Resources

Oracle Bills of Material > Operation Resources

Oracle Engineering > Calculate Lead Times

Oracle Bills of Material > Calculate Lead Times

Oracle Engineering > Transfer to Manufacturing

Oracle Engineering > Copy to Manufacturing
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Create Routings
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®

Create RoutingsCreate Routings

Oracle Manufacturing Release 11iOracle Manufacturing Release 11i
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• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary
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ObjectivesObjectives

After completing this module, you should be able to:
• Maintain the workday calendar
• Define resources and departments
• Create routings
• Calculate lead times
• Transfer product information

After completing this module, you should be able to:
• Maintain the workday calendar
• Define resources and departments
• Create routings
• Calculate lead times
• Transfer product information
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Using Oracle Applications HelpUsing Oracle Applications Help

1. Navigate to the Oracle Applications Navigator.
2. Select Help—>Window Help from the menu bar.

The Oracle Applications Help window is displayed.
3. Enter your search criteria, enclosed within

quotation marks, in the Help field and click Find.
Oracle Applications Help displays a list of topics
that meet your search criteria.

4. Click a topic to view detailed information.
Note: Click Search Instructions for help with
searching Oracle Applications Help.

1. Navigate to the Oracle Applications Navigator.
2. Select Help—>Window Help from the menu bar.

The Oracle Applications Help window is displayed.
3. Enter your search criteria, enclosed within

quotation marks, in the Help field and click Find.
Oracle Applications Help displays a list of topics
that meet your search criteria.

4. Click a topic to view detailed information.
Note: Click Search Instructions for help with
searching Oracle Applications Help.
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Using Oracle Applications Help Within a Window
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Using Oracle Applications Help Within a
Window

Using Oracle Applications Help Within a
Window

1. Open a window in the application you are using.
2. Select Help—>Window Help from the menu bar.

Oracle Applications Help displays detailed
information about the window you opened,
including step-by-step instructions for entering
information in each field in the window.

1. Open a window in the application you are using.
2. Select Help—>Window Help from the menu bar.

Oracle Applications Help displays detailed
information about the window you opened,
including step-by-step instructions for entering
information in each field in the window.
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• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary
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Workday CalendarWorkday Calendar

Workday Calendar
You use the workday calendar to specify to the Oracle manufacturing applications your
workdays, your non-workdays, and your shifts.
Workday exceptions make allowances for the days that will not conform to the workday
pattern.
Shifts are the times when workers will be productive and do not include breaks, lunch or
any other scheduled nonproductive time.
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Resources and DepartmentsResources and Departments

Resources and Departments
Resources are anything—except component material—required to manufacture,
cost, and schedule products. Each costed resource can have any number of
associated costs, including overhead cost. Once you assign resources to
routings, other Oracle Applications use them for setting item standard costs,
scheduling discrete jobs, and planning for capacity.
A department is a collection of resources designed to do certain tasks. A
department class is a collection of departments.
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RoutingsRoutings

Operation 10
Dept. A

Operation 10
Dept. A

Resource 1Resource 1 Resource 2Resource 2

AA

Operation 20
Dept. B

Operation 20
Dept. B

Resource 1Resource 1 Resource 2Resource 2

Routings
You use routings to specify the resources and departments that you use to
manufacture, cost, and schedule assembly items. You must create resources and
departments before you create routings.
You assign department resources to an operation.
If you need to have identical routings for more than one item, you can use the
common routings feature.
Create routings by copying an existing routing.
You can review the information you have entered with reports and view  screens.
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Calculating Lead TimesCalculating Lead Times

ItemItem    LT.LT. StartStart      CompleteComplete
AA 22 1717 1919
B B 6     6     9 9 1717
CC 55 1010 1717
D      D      66 2 2 1010
E      E      44 44 1010

JulyJuly

Lead time: 5Lead time: 5

Lead time: 6Lead time: 6

Lead time: 6Lead time: 6

Lead time: 2Lead time: 2

Lead time: 5Lead time: 5

D A

C

B

E

11 22 33 44 55 66 77 88 99 1010 1111 1212 1313 1414 1515 1616 1717 1818 1919 2020 2121

Lead Times
Lead times are item, operation, and operation resource attributes that refer to the
amount of time you need to obtain or manufacture an item.
You can:
• Plan material and resources quickly and accurately.
• Establish appropriate planning time fences for products.
• Create purchase orders for material, accounting for vendor lead time.
• Schedule material to arrive at an operation where it is consumed.
• Schedule each resource at an operation where it is consumed.
• Promise accurate product shipment dates.
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Transferring Product Information

EngineeringEngineering ProductionProduction

Transferring Product Information
When you decide that engineering information is ready for production, you
transfer the product information (items, bills of material, and routing) from
engineering to manufacturing.
Transferring removes the information from the engineering side and adds it to the
manufacturing side.
Copying leaves the information in the engineering side and creates a new item,
bill of material, and routing on the manufacturing side.
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IntegrationIntegration

OracleOracle
EngineeringEngineering

OracleOracle
InventoryInventory

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Inventory
You can use items from Oracle Inventory as assemblies for engineering or bills
of material routings.
Use lead times to perform reorder point planning.
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IntegrationIntegration

OracleOracle
EngineeringEngineering

OracleOracle
InventoryInventory

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Work in Process (WIP)
When you create discrete jobs and repetitive schedules, Oracle Work in Process
(WIP) bases the operations list on the routings of the assembly.
Discrete job detailed scheduling uses resource times from the routings of the
assembly.
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IntegrationIntegration

Oracle SupplyOracle Supply
Chain PlanningChain Planning

Oracle MasterOracle Master
Schedule/MRPSchedule/MRP

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Master Scheduling/MRP
and Oracle Supply Chain Planning

The requirements explosion helps you use lead times for lead time offset and
time fences.
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IntegrationIntegration

Oracle CapacityOracle Capacity

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Capacity
Capacity scheduling helps you use resource times from the routings of the
assembly.
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IntegrationIntegration

OracleOracle
PurchasingPurchasing

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Purchasing
Oracle Purchasing helps you use lead times for outside processing purchase
requisitions and purchase orders.
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IntegrationIntegration

OracleOracle
OrderOrder

ManagementManagement

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Order Management
The assemble-to-order processes use model and option class routings to create
configured routings that are unique to a sales order line.
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IntegrationIntegration

Oracle CostOracle Cost
ManagementManagement

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Cost Management
Oracle Cost Management helps you enter resource costs and overhead costs and
department overhead costs for the cost rollup process to set standard costs.
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Review QuestionReview Question

What must you create before you create routings?
1. Resources and departments
2. Lead times and operations
3. Engineering information and lead times
4. Bills of material and resources

What must you create before you create routings?
1. Resources and departments
2. Lead times and operations
3. Engineering information and lead times
4. Bills of material and resources
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What must you create before you create routings?
1. Resources and departments
2. Lead times and operations
3. Engineering information and lead times
4. Resources and bills of material

What must you create before you create routings?
1. Resources and departments
2. Lead times and operations
3. Engineering information and lead times
4. Resources and bills of material
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• Introduction
• Overview
• Maintaining the workday calendar
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• Transferring product information
• Summary
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Workday CalendarWorkday Calendar

Workday Calendar
You use the workday calendar to specify to the Oracle manufacturing
applications your workdays, your non-workdays, and your shifts. The workday
calendar is different from the financial calendars.

To completely create a calendar, you need to:
• Create a calendar name and starting and completion dates
• Specify a general workday pattern
• Specify exceptions to the general workday pattern
• Specify shifts
• Specify a shift workday pattern if it is different from the general workday

pattern
• Specify exceptions to any shift workday patterns
• Build the calendar
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Workday PatternsWorkday Patterns

Workday Patterns
You specify the regular pattern of workdays (days on) and nonworkdays (days
off). The calendar build process denotes each day as a day on or a day off
according to the workday pattern that you specify.
You must state a workday pattern for the plant. You can state a workday pattern
for a specific shift.
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Workday ExceptionsWorkday Exceptions

Workday exceptionsWorkday exceptions
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patternpattern
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Workday Exceptions
You usually have exceptions to the regular workday pattern. Workday
exceptions are:

• Specific days in the calendar that are days on according to the workday
pattern but that are actually days off, such as holidays.

• Specific days in the calendar that are days off according to the workday
pattern but that are actually days on, such as work on a weekend for the
end of a quarter.

• You can state workday exceptions for the plant and for a specific shift.
To specify exceptions, you can:

• View a graphical display of each month and select days that are exceptions
• Use a form to create a list of the exception days (exception list) for the

calendar
• Copy exception lists from other calendars
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Use the Exception Templates window to create
workday exception templates.
Use the Exception Templates window to create
workday exception templates.

In Oracle Bills of Material: (N) Setup > Exception Templates
(Help) Oracle Bills of Material > Workday Calendar > Creating a
Workday Exception Template
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Use the Workday Calendar window to create workday
calendars.
Use the Workday Calendar window to create workday
calendars.

In Oracle Bills of Material: (N) Setup > Calendars
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 3
(> Related Topics)
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This practice covers creating a workday calendar.This practice covers creating a workday calendar.

Practice 1 Instructions
1. Create a workday calendar with a workday pattern and shifts that match your
facility.
2. View the calendar months.
3. Apply exceptions to the calendar and view the exceptions if necessary.
4. Build the calendar.
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Create a workday calendar.Create a workday calendar.

Practice 1 Solution
1. Create a workday calendar with workday pattern and shifts that match your
facility.
(N) Bills of Material > Setup > Calendars (B) Workday Pattern
(N) Bills of Material > Setup > Calendars (B) Shifts
2. View the calendar or shift months.
(N) Bills of Material > Setup > Calendars (B) Shifts (B) Dates
3. Apply exceptions to the calendar and view the exceptions if necessary.
(N) Bills of Material > Setup > Calendars (M) Tools > Exception
Templates, then (B) Dates > Exception List or (B) Shifts (B) Dates >
Exception List
To copy, use (N) Bills of Material > Setup > Calendars (M) Tools > Copy
4. Build the calendar.
(N) Bills of Material > Setup > Calendars (M) Tools > Build
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Review QuestionReview Question

Which entity is not part of the workday calendar
process?
1. Build
2. Resources
3. Exceptions
4. Shifts

Which entity is not part of the workday calendar
process?
1. Build
2. Resources
3. Exceptions
4. Shifts
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Answer to Review QuestionAnswer to Review Question

Which entity is not part of the workday calendar
process?
1. Build
2. Resources
3. Exceptions
4. Shifts

Which entity is not part of the workday calendar
process?
1. Build
2. Resources
3. Exceptions
4. Shifts
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• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary
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Resources
Resources are anything—except component material—required to manufacture,
cost, and schedule products. You identify resources, associate them with
departments, state the resource work shifts. When you create routings, you as
sign them to its operations. Once in the routings, the resources are used for
setting item standard costs, scheduling discrete jobs, and planning for capacity.
For discrete manufacturing, resources include people (for example, a
machinist), machines or tools (for example, a drill press), space (for example, a
finished goods stockroom), and time (for example, queue time).
When you charge a resource, you add the cost of the resource to the cost of a
discrete job or a repetitive schedule in Oracle Work in Process (WIP).
You can permanently adjust the availability of the resource by using the
following factors:
· Utilization: The percent of time during which the resource is not performing
work on a product as described in the manufacturing routings. The routings
describe setup, run, and teardown times. For example, an employee who is
present for eight hours each day attends a planning meeting for one-half hour at
the beginning of each day and cleans up for one-half hour at the end of each
day. The employee’s utilization is seven hours of eight hours (7 / 8 * 100) or
87.5 percent.
· Efficiency: The percent of work that the resource can produce in a day in
relation to the standard times. For example, an employee is
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new and you expect that, for the first six months, the employee will be able to
complete 75 percent of the work of more experienced
employees doing the same work. Since you set your standard times based on
experienced employees, you indicate the new
employee’s utilization at 75 percent.
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Use the Resources window to define resources.Use the Resources window to define resources.

In Oracle Engineering: (N) Prototypes > Routings > Resources
In Oracle Bills of Material: (N) Routings > Resources
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 7
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Use the Resource Costs window to enter resource
unit costs.
Use the Resource Costs window to enter resource
unit costs.

In Oracle Engineering: (N) Prototypes > Routings > Resources (B)
Rates
In Oracle Bills of Material: (N) Routings > Resources (B) Rates
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 7
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Use the Resource Overhead Associations window to
specify the overhead charge type, cost, and resource
overhead.

Use the Resource Overhead Associations window to
specify the overhead charge type, cost, and resource
overhead.

In Oracle Engineering: (N) Prototypes > Routings >
Resources (B) Overheads
In Oracle Bills of Material: (N) Routings > Resources (B) Overheads
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 7
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Use the Quick Codes (CRP_RESOURCE_GROUPS)
window to define resource groups.
Use the Quick Codes (CRP_RESOURCE_GROUPS)
window to define resource groups.

In Oracle Bills of Material: (N) Setup > Resource Groups
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 8
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Use the Simulation Sets window to define simulation
sets.
Use the Simulation Sets window to define simulation
sets.

In Oracle Bills of Material: (N) Setup > Simulation Sets
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 9
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Department class: ProductionDepartment class: Production

Department: MachiningDepartment: Machining Department: WeldingDepartment: Welding

MachinistMachinist

Drill pressDrill press

Shift 2Shift 2

Shift 1Shift 1

Shift 2Shift 2

Shift 1Shift 1

WelderWelder

Welding
torch

Welding
torch

Shift 1Shift 1

Shift 1Shift 1

Departments and Department Classes
A departments is a collection of resources designed to do certain tasks. For
example, you might group the drill presses and machinists into a department.
Departments are also called work centers.
A department class is a collection of departments. For example, you might
group the welding, machining, plating, and painting departments into the
“manufacturing” department class, and you might group the unit test and final
test departments into the “quality” department class.
Resources, Departments, and Shifts
You assign resources to one or more departments, and you can share resources
with other departments.
A shift represents a period of time during which a resource is available for
work. You specify the times for your shifts in the workday calendar. When you
assign the resource to its department, you specify the shifts in which the
resource is available.
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Use the Department Classes window to define
department classes.
Use the Department Classes window to define
department classes.

In Oracle Bills of Material: (N) Setup > Department Classes
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 6
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Use the Location window to define locations to use
with outside processing items.
Use the Location window to define locations to use
with outside processing items.

In Oracle Bills of Material: (N) Setup > Locations
(Help) Oracle Purchasing > Setting Up > Defining Locations
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Use the Departments window to define departments.Use the Departments window to define departments.

In Oracle Engineering: (N) Prototypes > Routings > Departments
In Oracle Bills of Material: (N) Routings > Departments
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
11
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Use the Overhead Rates window to associate
overheads with departments.
Use the Overhead Rates window to associate
overheads with departments.

In Oracle Engineering: (N) Prototypes > Routings > Departments  (B)
Rates
In Oracle Bills of Material: (N) Routings > Departments (B) Rates
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
14
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Use the Resources window to assign resources to
departments.
Use the Resources window to assign resources to
departments.

In Oracle Engineering: (N) Prototypes > Routings > Departments (B)
Resources
In Oracle Bills of Material: (N) Routings > Departments (B) Resources
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
12
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Use the Shifts window to specify resource shifts.Use the Shifts window to specify resource shifts.

In Oracle Engineering: (N) Prototypes > Routings > Departments (B)
Resources (B) Shifts
In Oracle Bills of Material: (N) Routings > Departments (B) Resources
(B) Shifts
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
12
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Add capacity
Capacity change = +1
Available capacity =

24 hours

Add capacity
Capacity change = +1
Available capacity =

24 hours

Reduce capacity
Capacity change = -1
Available capacity =

8 hours

Reduce capacity
Capacity change = -1
Available capacity =

8 hours

Add work day
Capacity change = +2
Available capacity =

16 hours

Add work day
Capacity change = +2
Available capacity =

16 hours

Delete work day
Capacity change = -2
Available capacity = 0

Delete work day
Capacity change = -2
Available capacity = 0

Capacity Changes
A capacity change is a temporary change to the available capacity of a
resource—for example, work on a specific Saturday. You identify a capacity
modification for a resource within a shift for a resource. When you plan
capacity or detail schedule a resource that has capacity modifications, the
planning and scheduling processes might schedule work on a different day than
they would have scheduled the same work if there were no capacity change.
A simulation set is the label for a group of capacity changes needed for a
specific purpose—for example, a vacation schedule or an end-of-quarter
overtime schedule. You can simulate capacity changes by performing a capacity
plan using a simulation set.
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Use the Capacity Changes window to specify
capacity

changes.

Use the Capacity Changes window to specify
capacity

changes.

In Oracle Engineering: (N) Prototypes > Routings > Departments (B)
Resources (B) Shifts (B) Capacity Changes
In Oracle Bills of Material: (N) Routings > Departments (B) Resources
(B) Shifts (B) Capacity Changes
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
12
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This practice covers creating resources, department
classes, and departments.
This practice covers creating resources, department
classes, and departments.

Practice 2 Instructions
1. Create a department class code XX-PCMFG with description PC
Manufacturing Department Class.
2. Create resources using the following table:
Note: XX represents your team.
Resource Description Type
XXInserter Auto Inserter Machine
XXAssblr Labor Grade 1 Person
XXTester Tester Person
Note: For each resource, use the following additional information:
• UOM: HR
• Autocharge: WIP Move
• Default Basis: Item
• Costed: Yes
• Standard Rate: Yes
• Absorption Account: Any account number
• Variance Account: Any account number
• Overheads: Do not enter
• Resource Costs: Do not enter
• 3. Create departments using the following table:
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• Department Description Resource Name Capacity
Units
• XX-AutoIns Auto Insertion XXInserter 1
• XX-ManAssy Manual Assy XXAssblr 10
• XX-Test Testing XXTester 3
• XX-PCFinal PC Final Assy XXAssblr 4
• XX-PCFinal PC Final Assy XXTester 2
• Assign departments to class XX-PCMFG
• Note: For each resource, use the following additional information:
• Class: XX-PCMFG
• Shared: No
• Available 24 Hours: No
• Assigned Shifts: 1
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Practice 2 SolutionPractice 2 Solution

Create resources, department classes, and
departments.
Create resources, department classes, and
departments.

Practice 2 Solution
1. Create a department class code XX-PCMFG with description PC
Manufacturing Department Class.
(N) Bills of Material  > Setup > Department Classes
2. Create resources using the following table:
Note: XX represents your initials.
Resource Description Type
XXInserter Auto Inserter Machine
XXAssblr Labor Grade 1 Person
XXTester Tester Person
Note: For each resource, use the following additional information:
• UOM: HR
• Charge Type: WIP Move
• Default Basis: Item
• Costed: Yes
• Standard Rate: Yes
• Absorption Account: Any account number
• Variance Account: Any account number
• Overheads: Do not enter
• Resource Costs: Do not enter
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• (N) Engineering > Prototypes > Routings > Resources
• 3. Create departments using the following table:
• Department Description Resource Name Capacity
Units
• XX-AutoIns Auto Insertion XXInserter 1
• XX-ManAssy Manual Assy XXAssblr 10
• XX-Test Testing XXTester 3
• XX-PCFinal PC Final Assy XXAssblr 4
• XX-PCFinal PC Final Assy XXTester 2
• Assign departments to class XX-PCMFG.
• Note: For each resource, use the following additional information:
• Class: XX-PCMFG
• Share: No
• Available 24 Hours: No
• Assigned Shifts: 1
• (N) Engineering > Prototypes > Routings > Departments
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Review QuestionReview Question

Which of the following Entity : Action pairs is not
correct?
1. Resource : Assign to operation
2. Department class : Assign to department
3. Shift : Assign to resource
4. Capacity change : Assign to shift

Which of the following Entity : Action pairs is not
correct?
1. Resource : Assign to operation
2. Department class : Assign to department
3. Shift : Assign to resource
4. Capacity change : Assign to shift
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Answer to Review QuestionAnswer to Review Question

Which of the following Entity : Action pairs is not
correct?
1. Resource : Assign to operation
2. Department class : Assign to department
3. Shift : Assign to resource
4. Capacity change : Assign to shift

Which of the following Entity : Action pairs is not
correct?
1. Resource : Assign to operation
2. Department class : Assign to department
3. Shift : Assign to resource
4. Capacity change : Assign to shift
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• Introduction
• Overview
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• Transferring product information
• Summary
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Operation 20
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Operation 10
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Operation 10
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

AA

Engineering and Manufacturing Routings
You use routings to specify the process that you use to manufacture both
discrete and repetitive assembly items. A routing consists of operation steps.
Each operation step occurs at a department and contains resources that perform
work, schedule time, or add cost to the assembly.
Engineering routings are routings that your engineering function creates.
Manufacturing routings are routings that you use in production. You create
engineering routings in Oracle Engineering and you create manufacturing
routings in Oracle Inventory. They differ only in the following ways:
• Engineering routings have the routing Engineering attribute selected.
• Manufacturing routings have the routing Engineering attribute clear.
• You access the two through different navigation paths.
• They have different form titles.
• You create and change engineering routings using the Oracle Engineering
forms; you create and change manufacturing routings using the Oracle Bills of
Material forms.
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Resource 1Resource 1
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Operation disassemble
Dept. A

Operation disassemble
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 3Resource 3

AA AA

Defining Primary and Alternate Routings
Each item that has a routing has a primary routing. If you create other routings
for items, you refer to them as alternate routings. You use alternate routings in
the following ways:

• You identify each alternate routing by naming it. For example, you create
a primary routing to use when you manufacture the item and you want to
create another routing to use when you rework the item. Name the
alternate routing Rework.

• You can create as many alternate routings as you need for any item. The
alternate name must belong to the alternate list of values before you can
use it.

• You must add the name of the alternate routing to the list before you use it.
When you create discrete jobs and repetitive schedules in Oracle Work in
Process, you can specify which routing it should use when creating the
operations list. If you use an alternate routing, you can automatically create a
variance because standard cost is based on the primary routing.
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Operation 20
Dept. 222

Operation 20
Dept. 222

Operation 10
Dept. 111

Operation 10
Dept. 111

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

AA

Routings in Multiple Organizations
You create items in the master organization and assign them to the
manufacturing and distribution organizations in which you use them. Within the
assigned organization, you create routings.
Example
Creating a routing for item A in organization 1 with operation step 10 in
department 111 and operation step 20 in department 222
Creating a routing for item A in organization 2 with operation step 10 in
department 111 and operation step 20 in department 222
Creating a routing for item A in organization 3 with operation step 10 in
department 333 and operation step 20 in department 444
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Use the following windows to enter routings:
• Engineering Routings in Oracle Engineering
• Routings in Oracle Bills of Material

Use the following windows to enter routings:
• Engineering Routings in Oracle Engineering
• Routings in Oracle Bills of Material

In Oracle Engineering: (N) Prototypes > Routings > Routings
In Oracle Bills of Material: (N) Routings > Routings
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Creating a Routing
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Assigning a Completion Subinventory and Locator
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Operation 20
Dept. new

Operation 20
Dept. new

Operation 10
Dept. A

Operation 10
Dept. A

Resource newResource new

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

Operation 20
Dept. B

Operation 20
Dept. B

Operation 10
Dept. A

Operation 10
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

AA AA

Defining Routing Revisions
A routing revision helps you indicate that the operations and resources of an
item have changed. You do not have to use routing revisions when you change
routings. Oracle Engineering and Oracle Bills of Material date stamp all
changes that you make to routings when you increase the revision.
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Use the Routing Revisions window to create routing
revisions.
Use the Routing Revisions window to create routing
revisions.

In Oracle Engineering: (N) Prototypes > Routings > Routings (B)
Routing Revisions
In Oracle Bills of Material: (N) Routings > Routings (B) Routing
Revisions
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Creating a Routing Revision
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Use the Viewing Routings window to view routings.Use the Viewing Routings window to view routings.

In Oracle Engineering: (N) Prototypes > Routings > Routings
In Oracle Bills of Material: (N) Routings > Routings
(Help) <no help available>
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Use the Reports window to request routing reports.Use the Reports window to request routing reports.

In Oracle Engineering and Oracle Bills of Material: (N) Reports >
Routings
(Help) Oracle Bills of Material > Reports and Processes > ...
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Use the Operation Resources window to create
operation resources.
Use the Operation Resources window to create
operation resources.

In Oracle Engineering: (N) Prototypes > Routings > Routings (B)
Operation Resources
In Oracle Bills of Material: (N) Routings > Routings (B) Operation
Resources
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Assigning Operation Resources
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Defining Standard Operations
A standard operation holds operation and resource information. Create a
standard operation for an operation that you will use in many routings. As you
create specific routings, you can copy standard operations to an operation. The
operation and resource information will copy to the routing and you can change
any of the information after the copying is complete.
A standard operation is not the same as a standard bill of material.
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Use the Standard Operations window to create
standard operations.
Use the Standard Operations window to create
standard operations.

In Oracle Engineering: (N) Prototypes > Routings > Standard
Operations
In Oracle Bills of Material: (N) Routings > Standard Operations
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
17
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Use the Resources window to create standard
operation resources.
Use the Resources window to create standard
operation resources.

In Oracle Engineering: (N) Prototypes > Routings > Standard
Operations (B) Operation Resources
In Oracle Bills of Material: (N) Routings > Standard Operations (B)
Operation Resources
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
17
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Use the Resource WhereUsed window to view the
routings and operations that use a resource.
Use the Resource WhereUsed window to view the
routings and operations that use a resource.

In Oracle Engineering: (N) Prototypes > Routings > Resource
WhereUsed
In Oracle Bills of Material: (N) Routings > Resource WhereUsed
(Help) Oracle Bills of Material > Routings > Viewing Resource Usage
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Use the Attachments window to add attachments to a
routing.
Use the Attachments window to add attachments to a
routing.

In Oracle Engineering: (N) Prototypes > Routings > Routings (M) Edit
> Attachments
In Oracle Bills of Material: (N) Routings > Routings (M) Edit >
Attachments
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Attaching Files
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Use the Operation Documents window to create and
change routing attachments.
Use the Operation Documents window to create and
change routing attachments.

In Oracle Engineering: (N) Prototypes > Routings > Documents
In Oracle Bills of Material: (N) Routings > Documents
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Attaching Files > Related Topics > Defining Bill or Routing Operation
Documents
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Use the Tools menu bar choice to perform a variety of
routing functions.
Use the Tools menu bar choice to perform a variety of
routing functions.

In Engineering: (N) Prototypes > Routings > Routings (M) Tools
In Bills of Material: (N) Routings > Routings (M) Tools
(Help) Oracle Bills of Material > Routings > Routings Reference >
Tools menu
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Common RoutingsCommon Routings

Operation 20
Dept. B

Operation 20
Dept. B

Operation 10
Dept. A

Operation 10
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

AA XX

Creating Common Routings
If you need to have identical routings for more than one item, you can save time
and reduce the necessity for maintenance by using the common routing feature.
The routing you reference contains the operations and resources. The routing
that is referencing does not contain operations and resources; it contains a link
to the referenced routing. Any function that uses or views the referencing
routing will use or view the routing of the referenced routing.
Make all changes to the original routing. The routings that reference the
common routing will reflect the changes.
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Use the Common Routing window to assign an item
to a common routing.
Use the Common Routing window to assign an item
to a common routing.

In Oracle Engineering: (N) Prototypes > Routings > Routings  (M)
Tools > Assign Common Routing
In Oracle Bills of Material: (N) Routings > Routings  (M) Tools >
Assign Common Routing
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Referencing Common Bills and Routings
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Copy RoutingsCopy Routings

Operation 20
Dept. B

Operation 20
Dept. B

Operation 10
Dept. A

Operation 10
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

Operation 20
Dept. B

Operation 20
Dept. B

Operation 10
Dept. A

Operation 10
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

AA XX

Copy Routings
When you want to create similar, alternate routings for and item, you can save
time creating routings by using the Copy Routing feature.
You create a routing by copying from:
The same or a different item number
The primary or an alternate bill for that item number
The item from which you copy retains its operations and resources. The item to
which you copy contains the same operations and resources as the item from
which you copy.
You can change anything on the copied routing except the item number and the
operation number.
After copying, the two routings are no longer related. If you change one routing,
you do not see the same change in the other routing.
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Use the Copy Routing window to copy the routing of
one item as the routing of another item.
Use the Copy Routing window to copy the routing of
one item as the routing of another item.

In Oracle Engineering: (N) Prototypes > Bills > Bills (M) Special >
Copy Routing from
In Oracle Bills of Material: (N) Bills > Bills (M) Special > Copy Routing
from
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Copying Bill & Routing Information



Copyright © Oracle Corporation, 2000. All rights reserved.

Oracle Manufacturing - Create Routings Release 11i
Chapter 1 - Page 80

Routing Open Interface

Copyright   Oracle Corporation,  2000. All rights reserved.
®

LegacyLegacy
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DataData
ManagementManagement

SystemsSystems

OracleOracle

Open interface
tables

Routing Open InterfaceRouting Open Interface

PDMPDM

OracleOracle
ApplicationsApplications
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Use the Import Bills and Routings window to create,
update, and delete routing information from external
systems.

Use the Import Bills and Routings window to create,
update, and delete routing information from external
systems.

In Oracle Engineering: (N) Prototypes > Routings > Import
In Oracle Bills of Material: (N) Routings > Import
(Help) Oracle Bills of Material > Routings > Importing Bills and
Routings
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This practice covers creating routings.This practice covers creating routings.

Practice 3 Instructions
1. Create a routing for item XX1000 using the following tables:
Note: XX represents your team.
Operation Sequence Department Description
100 XX-PCFinal Assemble PC
200 XX-PCFinal Test PC
Operation  Resource Usage Rate Assigned
Sequence  Sequence Name or Amount Basis Units
100 10 XXAssblr 0.25 Item 4
200 10 XXTester 0.5 Item 1
Note: For each resource, use the following additional information:
• UOM: HR
• Schedule: Yes
• 2. Create a routing for item XX1040 using the following tables:
• Operation Sequence Department Description
• 100 XX-PCFinal Assemble CPU Chassis
• 200 XX-PCFinal Test CPU Chassis
• Operation  Resource Usage Rate Assigned
Sequence  Sequence Name or Amount Basis Units
• 100 10 XXAssblr 0.5 Item 4
• 200 10 XXTester 1 Item 1
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• Note: For each resource, use the following additional information:
• UOM: HR
• Schedule: Yes
• 3. Create a routing for item XX2010 using the following tables:
• Operation Sequence Department Description
• 100 XX-AutoIns Machine install components
• 200 XX-ManAssy Hand install components
• 300 XX-Test Test motherboard
• Operation  Resource Usage Rate Assigned
Sequence  Sequence Name or Amount Basis Units
• 100 10 XXInserter 2 Lot 1
• 100 20 XXInserter 1 Item 1
• 200 10 XXAsslbr 0.1 Item 10
• 300 10 XXTester 2 Item 1
• Note: For each resource, use the following additional information:
• UOM: HR
• Schedule: Yes
• 4. Return to your bill of material and assign routing operation sequences to
your components.
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Practice 3 SolutionPractice 3 Solution

Create routings.Create routings.

Practice 3 Solution
1. Create a routing for item XX1000 using the following tables:
Note: XX represents your team.
Operation Sequence Department Description
100 XX-PCFinal Assemble PC
200 XX-PCFinal Test PC
Operation  Resource Usage Rate Assigned
Sequence  Sequence Name or Amount Basis Units
100 10 XXAssblr 0.25 Item 4
200 10 XXTester 0.5 Item 1
Note: For each resource, use the following additional information:
• UOM: HR
• Schedule: Yes
• (N) Engineering > Prototypes > Routings > Routings
• 2. Create a routing for item XX1040 using the following tables:
• Operation Sequence Department Description
• 100 XX-PCFinal Assemble CPU Chassis
• 200 XX-PCFinal Test CPU Chassis
• Operation  Resource Usage Rate Assigned
Sequence  Sequence Name or Amount Basis Units
• 100 10 XXAssblr 0.5 Item 4
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• 200 10 XXTester 1 Item 1
• Note: For each resource, use the following additional information:
• UOM: HR
• Schedule: Yes
• (N) Engineering > Prototypes > Routings > Routings
• 3. Create a routing for item XX2010 using the following tables:
• Operation Sequence Department Description
• 100 XX-AutoIns Machine install components
• 200 XX-ManAssy Hand install components
• 300 XX-Test Test motherboard
• Operation  Resource Usage Rate Assigned
Sequence  Sequence Name or Amount Basis Units
• 100 10 XXInserter 2 Lot 1
• 100 20 XXInserter 1 Item 1
• 200 10 XXAsslbr 0.1 Item 10
• 300 10 XXTester 2 Item 1
• Note: For each resource, use the following additional information:
• UOM: HR
• Schedule: Yes
• (N) Engineering > Prototypes > Routings > Routings
• 4. Return to your bill of material and assign routing operation sequences to
your components.
• (N) Engineering > Prototypes > Bills > Bills
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Review QuestionReview Question

Engineering and manufacturing routing differ in all of
the following areas except one. Which one is it?
1. Engineering attribute
2. Navigation path
3. Form title
4. Operation numbers

Engineering and manufacturing routing differ in all of
the following areas except one. Which one is it?
1. Engineering attribute
2. Navigation path
3. Form title
4. Operation numbers
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Engineering and manufacturing routing differ in all of
the following areas except one. Which one is it?
1. Engineering attribute
2. Navigation path
3. Form title
4. Operation numbers

Engineering and manufacturing routing differ in all of
the following areas except one. Which one is it?
1. Engineering attribute
2. Navigation path
3. Form title
4. Operation numbers
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• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary



Copyright © Oracle Corporation, 2000. All rights reserved.

Oracle Manufacturing - Create Routings Release 11i
Chapter 1 - Page 89

Lead Times

Copyright   Oracle Corporation,  2000. All rights reserved.
®

ItemItem    LT.LT. StartStart      CompleteComplete
AA 22 1717 1919
B B 6     6     9 9 1717
CC 55 1010 1717
D      D      66 2 2 1010
E      E      44 44 1010

JulyJuly

Lead time: 5Lead time: 5

Lead time: 6Lead time: 6

Lead time: 6Lead time: 6

Lead time: 2Lead time: 2

Lead time: 5Lead time: 5

D A

C

B

E

11 22 33 44 55 66 77 88 99 1010 1111 1212 1313 1414 1515 1616 1717 1818 1919 2020 2121

Lead TimesLead Times

Lead Times
Plan material and resource requirements and determine requirement dates for
available-to-promise calculations using dynamic lead times.
Dynamic Lead Time Offsetting: Estimate the start date of an order, an
operation, or a resource based on order quantity, lead times, and the workday
calendar.
Detailed Scheduling: Schedule jobs to the minute based on detailed resource
availability and usages. Oracle Bills of Material calculates manufacturing lead
times using detailed scheduling. Detailed scheduling is the most precise
scheduling method in Oracle Manufacturing.
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Lead Time AttributesLead Time Attributes

Preprocessing
lead time

Preprocessing
lead time

Processing
lead time

Processing
lead time

Postprocessing
lead time

Postprocessing
lead time

Preprocessing
lead time

Preprocessing
lead time

Lead time offset
(fixed and variable)
Lead time offset

(fixed and variable)
MakeMake
itemitem

BuyBuy
itemitem

Lead Time Attributes
Preprocessing Lead Time: Represents the time required to release a purchase
order or a job from the time you learn of the requirement.
Postprocessing Lead Time: Represents the time to make a purchased item
available in inventory from the time you receive it: you manually enter
postprocessing lead time for each purchased item.
Processing Lead Time: Time required to procure or manufacture an item;
processing lead time includes the fixed and variable portions of lead times.
Cumulative Manufacturing Lead Time: Total time required to make an item
if you had all raw materials in stock but had to make all subassemblies level by
level; Oracle automatically calculates this value.
Cumulative Total Lead Time: Total time required to make an item if no
inventory existed and you had to order all the raw materials and make all
subassemblies level by level; Oracle automatically calculates this value.
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ManuallyManually
enterenter

ConcurrentConcurrent
processprocess

Assigning Lead Time Values
To assign values to lead time attributes, you can do either of the following:

• Manually enter them.
• For make items, start concurrent processes that calculate them. These

processes replace values that you have manually entered with calculated
values.
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Calculating Lead TimesCalculating Lead Times

RoutingsRoutings

SupplierSupplier

The Lead Time Calculation Process
Use the following process if you want Oracle Engineering or Oracle Bills of
Material to calculate lead time information:

• For buy items, manually enter preprocessing, processing, and
postprocessing attributes.

• For make items, enter routings and manually enter preprocessing and lead
time lot size attributes.

• Start the concurrent process Calculate Manufacturing Lead Times, which
calculates the fixed, variable, processing, lead time percentage, and offset
percentage attributes.

• Start the concurrent process Roll Up Cumulative Lead Times, which
calculates the cumulative manufacturing and cumulative total attributes.
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Value
Assigned

YES

YES

YES

Attribute

Fixed Order Quantity

Min-Max Order Quantity

Standard Lot Size

Value for Lead Time Lot
Size

Fixed Order Quantity

Average Order Quantity

<none>

Lead Time Lot Size
Specify the quantity to use when calculating dynamic manufacturing lead times
based on how you plan and cost the item.
Lead Time Lot Size Item Attribute
Schedule the first job in dynamic lead time calculations for the quantity of zero
and to schedule the second job in dynamic lead time calculations for the lead time
lot size.
No Lead Time Lot Size Assigned
You use default standard lot size, which defaults to the item’s standard lot size
attribute if there is no lead time lot size entered in the lead times region of this
form. The default lead time lot size of “1” will default the item’s lead time lot size
to “1” if there is no standard lot size.
Value Assigned Attribute Value for Lead Time Lot Size
YES Fixed Order Quantity Fixed Order Quantity
YES Min-Max Order Quantity Average Order Quantity
YES Standard Lot Size None
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Manufactured Item Lead TimesManufactured Item Lead Times

Attribute

Preprocessing

Processing

Postprocessing

Fixed

Variable

Cumulative Mfg

Cumulative Total

Lead Time Lot Size

Manually
Assign

YES

YES

Auto
Calculate

YES

YES

YES

YES

YES

Lead Time
Offset

YES

YES

Used for
Time Fences

YES

YES

Manufacturing Lead Times
Oracle Engineering computes the fixed and variable portion of manufacturing
(processing) lead time using routings and detailed scheduling.

Calculate Processing Lead Time for Manufactured Items
Schedule one discrete job for a quantity of zero (fixed lead time), and a second
discrete job for the lead time lot size quantity (variable lead time).
When computing processing lead time, engineering schedules all calendar days
as workdays, regardless of days off or workday exceptions.
Fixed and Variable Lead Time
Fixed lead time is defined as the portion of time required to build an assembly
that is independent of order quantity. Setup and teardown are examples of fixed
lead time.
Variable lead time is defined as the time required to produce one additional unit
of an assembly
Oracle Manufacturing uses an item’s fixed lead time and variable lead time in
dynamic lead time offset calculations.
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Manufactured Item Lead Time PercentageManufactured Item Lead Time Percentage

Operation
Sequence

10

20

30

Operation Description

Assemble Chassis Base

Mount Motherboard

Package Product

Lead Time
Percentage

0%

50%

80%

Start
Day

1

6

9

Duration
(1 LTLS)

5

3

2

Reference InformationReference Information
Processing Lead Time = 10 daysProcessing Lead Time = 10 days

LTLS - Lead Time Lot SizeLTLS - Lead Time Lot Size

Manufacturing Lead Times (continued)
Oracle Manufacturing computes resource and operation offsets automatically
when calculating Manufacturing Lead Time.

Operation Lead Time Percentage
Engineering automatically calculates the percentage of total manufacturing lead
time required for previous operations, calculated from the start of a job to the
start of an operation. You can override lead time percent calculations in the
main region of the engineering routings window.
Schedule material to arrive when an operation requires it. Oracle Master
Scheduling/MRP uses offsets to determine when an operation requires material.
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Manufactured Item Resource OffsetsManufactured Item Resource Offsets
Op
Seq

10

20

20

30

Resource
Description

Assemble chassis

Detailed system test

Assemble

Pack

Offset
Percentage

0%

50%

60%

80%

Start
Day

1

6

7

9

Duration
(1 LTLS)

5

1

2

2

Reference InformationReference Information
OpOp Seq Seq = Operation Sequence = Operation Sequence
Res SeqRes Seq = Resource Sequence = Resource Sequence

Processing Lead Time = 10 daysProcessing Lead Time = 10 days
LTLS - Lead Time Lot SizeLTLS - Lead Time Lot Size

Resource Offsets
Oracle Engineering automatically calculates the percentage of total
manufacturing lead time required for previous operations, calculated from the
start of the job to the start time of a resource at an operation. You can override
offset percentage calculations in the Resource zone of the Define Engineering
routing form.
Schedule Resources
Schedule resources at an operation exactly when they are required. Oracle
Capacity uses operation and resource offsets, as well as detailed usage
information, to plan operation resources.
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Time (Days)Time (Days)

Assembly:
Made

Subassembly:
Made

ProcessingProcessing
lead timelead time

Cumulative manufacturingCumulative manufacturing
lead timelead time

PreprocessingPreprocessing
ProcessingProcessing

Rollup Lead Times
Cumulative manufacturing lead time formula:
Cumulative manufacturing lead time = Manufacturing lead time for item +
maximum [(Cumulative manufacturing lead time – Offset days of any
component)]
Set planning time fences for items based on cumulative manufacturing or
cumulative total lead time.
Cumulative manufacturing lead time: The total time required to make an item
if you had all raw materials in stock but had to make all subassemblies level by
level. Engineering automatically calculates this value.
Cumulative total lead time: The total time required to make an item if no
inventory existed and you had to order all the raw materials and make all the
subassemblies level by level. Engineering automatically calculates this value.
Compute cumulative manufacturing lead time: Calculate the maximum
component cumulative manufacturing lead time less operation offset.
Cumulative manufacturing lead time for a purchased item is zero.
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Time (Days)Time (Days)

Cumulative total lead timeCumulative total lead time

Assembly:
Made

Subassembly:
Made

Component:
Purchased

ProcessingProcessing
lead timelead time

Cumulative ManufacturingCumulative Manufacturing
lead timelead time

PreprocessingPreprocessing
ProcessingProcessing
PostprocessingPostprocessing

Cumulative Total Lead Time Formula
Cumulative total lead time = Total lead time for item + Maximum [(Cumulative
total lead time – Offset days for any component)]
Compute Cumulative Total Lead Time
Calculate an item’s own total lead time plus the maximum value of cumulative
total lead time operation offset for any component.
For cumulative calculations, include the postprocessing lead time for a
purchased item.
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Navigation PathNavigation Path

Use the following windows to set lead time item
attributes:
• Engineering Master Items and Engineering

Organization Items in Oracle Engineering
• Master Items and Organization Items in Oracle

Inventory

Use the following windows to set lead time item
attributes:
• Engineering Master Items and Engineering

Organization Items in Oracle Engineering
• Master Items and Organization Items in Oracle

Inventory

In Oracle Engineering:
• Engineering Master Items: (N) Prototypes > Items > Master Items
• Engineering Organization Items: (N) Prototypes > Items >
Organization Items
• In Oracle Inventory:
• Master Items: (N) Items > Master Items
• Organization Items: (N) Items > Organization Items
• (Help) Oracle Inventory > Items > Item Attribute Descriptions > Lead
Times Attribute Group
• (Help) Oracle Inventory > Items > Defining Items
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Use the following windows to set routing lead time
percentage:
• Engineering Routings in Oracle Engineering
• Routings in Oracle Bills of Material

Use the following windows to set routing lead time
percentage:
• Engineering Routings in Oracle Engineering
• Routings in Oracle Bills of Material

In Oracle Engineering: (N) Prototypes > Routings > Routings
In Oracle Bills of Material: (N) Routings > Routings
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Creating a Routing
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Navigation PathNavigation Path

Use the Operation Resources window to set resource
offset percentage.
Use the Operation Resources window to set resource
offset percentage.

In Oracle Engineering: (N) Prototypes > Routings > Routings (B)
Operation Resources
In Oracle Bills of Material: (N) Routings > Routings (B) Operation
Resources
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Assigning Operation Resources
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Use the Calculate Lead Times window to request
automatic lead time calculation.
Use the Calculate Lead Times window to request
automatic lead time calculation.

In Oracle Engineering: (N) Prototypes > Routings > Lead Times
In Oracle Bills of Material: (N) Routings > Lead Times
(Help) Oracle Bills of Material > Lead Tine Management > Calculating
Lead Times
(Help) Oracle Bills of Material > Lead Tine Management > Rolling Up
Lead Times
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Practice 4 OverviewPractice 4 Overview

This practice covers entering and calculating lead
times.
This practice covers entering and calculating lead
times.

Practice 4 Instructions
1.Enter lead times for your buy items using the following table:
Lot size for XXXX1000, XX1040, XX2010 is 100 pieces.
Item Number Preprocessing LT Processing LT

Postprocessing LT
XX1010 5 5
XX1020 5 5
XX1030 5 5
XX2020 5 5 2
XX2030 5 5
XX2040 5 5
XX3010 5 10 2
XX3020 5 60 1
XX3030 5 5
XX3040 5 30 1
2. Calculate lead time for items XX2010, XX1040, and XX1000.
3. View fixed, variable, and processing lead times for items XX2010, XX1040,
and XX1000.
Note
• One hour of lead time = 1/24 = 0.0416667 day
• Two hours of lead time = 2/24 = 0.0833333 day
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• Four hours of lead time = 4/24 = 0.166666 day
• Eight hours of lead time = 8/24 = 0.333333 day
• Twelve hours of lead time = 12/24 = 0.5 day
• Twenty-four hours of lead time = 24/24 = 1 day
• 4. Roll up lead time for item XX1000.
• 5. View cumulative lead times for item XX1000.
• 6. View indented bill of material for XX1000.
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Enter and calculate lead times.Enter and calculate lead times.

Practice 4 Solution
1. Enter lead times for your buy items using the following table:
(N) Engineering > Prototypes > Items > Master Items (M) Tools >
Organization Assignment (B) Org Attributes (T) Lead Times
Lot size for XX1000, XX1040, XX2010 is 100 pieces.
Item Number Preprocessing LT Processing LT

Postprocessing LT
XX1010 5 5
XX1020 5 5
XX1030 5 5
XX2020 5 5 2
XX2030 5 5
XX2040 5 5
XX3010 5 10 2
XX3020 5 60 1
XX3030 5 5
XX3040 5 30 1
2. Calculate lead time for items XX2010, XX1040, and XX1000.
(N) Engineering > Prototypes > Routings > Lead Times
3. View fixed, variable, and processing lead times for items XX2010, XX1040,
and XX1000.
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(N) Engineering > Prototypes > Items > Master Items (M) Tools >
Organization Assignment (B) Org Attributes (T) Lead Times
Note:
• One hour of lead time = 1/24 = 0.0416667 day
• Two hours of lead time = 2/24 = 0.0833333 day
• Four hours of lead time = 4/24 = 0.166666 day
• Eight hours of lead time = 8/24 = 0.333333 day
• Twelve hours of lead time = 12/24 = 0.5 day
• Twenty-four hours of lead time = 24/24 = 1 day
• 4. Roll up lead time for item XX1000.
• (N) Engineering > Prototypes > Routings > Lead Times
• 5. View cumulative lead times for item XX1000.
• (N) Engineering > Prototypes > Items > Master Items (M) Tools >
Organization Assignment (B) Org Attributes (T) Lead Times
• 6. View indented bill of material for item XX1000.
• (N) Engineering > Prototypes > Bills > Indented Bills
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Review QuestionReview Question

If you want to automatically calculate the lead time of
a manufactured item, which of the following lead
times must you enter?
1. Preprocessing
2. Fixed
3. Postprocessing
4. Processing

If you want to automatically calculate the lead time of
a manufactured item, which of the following lead
times must you enter?
1. Preprocessing
2. Fixed
3. Postprocessing
4. Processing
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If you want to automatically calculate the lead time of
a manufactured item, which of the following lead
times must you enter?
1. Preprocessing
2. Fixed
3. Postprocessing
4. Processing

If you want to automatically calculate the lead time of
a manufactured item, which of the following lead
times must you enter?
1. Preprocessing
2. Fixed
3. Postprocessing
4. Processing
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AgendaAgenda

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary
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Transferring Product Information

EngineeringEngineering ProductionProduction

Transferring Product Information
When you decide that engineering information is ready for production, you
transfer the product information—items, bills of material, and routings— from
engineering to manufacturing.
When you transfer engineering information, you transform the engineering item
into a manufacturing item and the engineering item ceases to exist.
When you copy engineering information, you save the engineering information
and copy it to manufacturing as another item number.
The transfer and copy sequence is a one-way process. You cannot transfer or copy
product information from manufacturing to engineering.
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Navigation PathNavigation Path

Use the Transfer to Manufacturing window to transfer
engineering prototype items, bills of material, and
routings to production.

Use the Transfer to Manufacturing window to transfer
engineering prototype items, bills of material, and
routings to production.

In Oracle Engineering: (N) Prototype > Transfer to Manufacturing
(Help) Oracle Engineering > Engineering Prototype Environment >
Transferring or Copying Engineering Items
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Use the Copy to Manufacturing window to copy
engineering prototype items, bills of material, and
routings to production.

Use the Copy to Manufacturing window to copy
engineering prototype items, bills of material, and
routings to production.

In Oracle Engineering: (N) Prototype > Copy to Manufacturing
(Help) Oracle Engineering > Engineering Prototype Environment >
Transferring or Copying Engineering Items
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Practice 5 OverviewPractice 5 Overview

This practice covers transferring product information.This practice covers transferring product information.

Practice 5 Instructions
1. Transfer bills of material and routings for item numbers XX2010, XX1040, and
XX1000 from engineering to production.
Note: XX represents your team.
2. To verify the transfers, view XX1000 on the following forms and indicate
whether or not you are able to use each form to see the items:
• Oracle Inventory Master Items
• Oracle Engineering Master Items
• Oracle Inventory View Item Attributes
• Oracle Engineering View Item Attributes
• Oracle Bills of Material
• Oracle Engineering Bill of Material
• Oracle Bills of Material Indented Bills
• Oracle Engineering Indented Bills
• Oracle Bills of Material Routings
• Oracle Engineering Routings
• 3. Copy item XX2011 and give it a new name using item number XX2022. View
your results.
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Practice 5 SolutionPractice 5 Solution

Transfer product information.Transfer product information.

Practice 5 Solution
1. Transfer bills of material and Routings for item numbers XX2010, XX1040,
and XX1000 from engineering to production.
Note: XX represents your team.
(N) Engineering > Prototypes > Transfer to Manufacturing
2. To verify the transfers, view XX1000 on the following forms and indicate
whether or not you are able to use each form to see the items:
• Oracle Inventory Master Items
• (N) Inventory > Items—>Master Items; not able to see the items
• Oracle Engineering Master Items
• (N) Engineering > Prototypes—>Items—>Master Items; able to see the
items
• Oracle Inventory View Item Attributes
• (N) Inventory > Items—>Item Information; able to see the items
• Oracle Engineering View Item Attributes
•  (N) Engineering > Prototypes—>Items—>View Item Details; able to see the
items
• Oracle Bills of Material Bill of Material
• (N) Bills of Material > Bills—>Bills; able to see the items
• Oracle Engineering Bill of Material
• (N) Engineering > Prototypes—>Bills—>Bills; not able to see the items
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• Oracle Bills of Material Indented Bills
• (N) Bills of Material > Bills—>Indented Bills; able to see the items
• Oracle Engineering Indented Bills
• (N) Engineering > Prototypes—>Bills—>Indented Bills; able to see the items
• Oracle Bills of Material Routings
• (N) Bills of Material > Routings—>Routings; able to see the items
• Oracle Engineering Routings
• (N) Engineering > Prototypes—>Routings—>Routings; not able to see the
items
• 3. Copy item XX2011 and give it a new name using item number XX2022. View
your results.
• (N) Engineering > Prototype > Copy to Manufacturing
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Review QuestionReview Question

In which of the following transfer functions does the
engineering item remain?
1. Assign common routing
2. Transfer to manufacturing
3. Copy to manufacturing
4. Roll-up lead times

In which of the following transfer functions does the
engineering item remain?
1. Assign common routing
2. Transfer to manufacturing
3. Copy to manufacturing
4. Roll-up lead times
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In which of the following transfer functions does the
engineering item remain?
1. Assign common routing
2. Transfer to manufacturing
3. Copy to manufacturing
4. Roll-up lead times

In which of the following transfer functions does the
engineering item remain?
1. Assign common routing
2. Transfer to manufacturing
3. Copy to manufacturing
4. Roll-up lead times
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• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary
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SummarySummary

In this module, you should have learned how to:
• Maintain the workday calendar
• Define resources and departments
• Create routings
• Calculate lead times
• Transfer product information

In this module, you should have learned how to:
• Maintain the workday calendar
• Define resources and departments
• Create routings
• Calculate lead times
• Transfer product information
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